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1 Overview 
 
As leader of the mobileGT� alliance, Motorola is pleased to announce the first Standard 
Development Platform (SDP) for mobileGT. This complete development system includes a robust 
target hardware system designed around the highly integrated, automotive-qualified MPC823e 
PowerPC processor. It also includes a complete software development tool set for Microsoft 
Windows�-hosted development of Java and QNX C/C++ applications, using the popular 
CodeWarrior Integrated Development Environment (IDE). 
 
Motorola, as part of their Driver Information Systems (DIS) business, has formed an alliance of 
best-of-breed companies to create the mobileGT architecture. This architecture is targeted for 
development of in-vehicle client systems in the automotive market. The expertise of the combined 
companies has led to an optimum balance of cost, quality, and time-to-market for both 
development efforts and production solutions. As the software investment grows, the new 
PowerPC processors and mobileGT platforms extend the automotive product developments. 
 
QNX Software Systems Ltd. provides the software foundation for the system. The QNX RTOS 
(Real Time Operating System) combines a fault-tolerant architecture with a small memory 
footprint. Designed for dynamically upgradable mobile systems, the QNX RTOS allows new 
applications and drivers to be downloaded and started on the fly, no reboot or user-intervention 
required. This allows OEMs to maintain or upgrade systems’ services long after the vehicle has 
been sold with minimal or no impact to the customer. 
 
IBM's implementation of Java technology is supported with the IBM VisualAge Micro Edition tools, 
providing everything needed by embedded Java developers. The J9 Virtual Machine from Object 
Technologies International has real-time Java2 technology and supports multiple Java class 
libraries, including certain Java-compatible configurations. J9 is optimized to work with QNX at the 
thread level, delivering excellent performance for embedded applications. J9 also supports OSGi 
bundle management for dynamic downloads and runtime code replacement.  
 
Metrowerks provides the popular CodeWarrior IDE, which speeds development time by creating, 
compiling, linking, assembling, and debugging within an integrated development environment. The 
project manager and build system enable the creation of solid code and shorten the 
compile/edit/debug cycles. The tightly integrated CodeWarrior development environment with its 
intuitive GUI (Graphical User Interface) for embedded development enhances software 
productivity.  
 
Embedded Planet designs and builds the target system hardware. The flexible hardware allows 
developers to configure the solutions to the optimum set of available Input/Output (I/O). The 
integrated TFT LCD display with touch screen is helpful for product developments requiring a 
graphics Human Machine Interface (HMI.) The RPX bus interface provides for custom hardware 
solutions to be quickly added to the standard Micro Processing Unit (MPU) board, which reduces 
cost and cycle time for prototyping custom solutions. 
 
The MPC823e PowerPC processor provides an automotive-qualified, high-performance 32-bit 
MPU with highly integrated I/O. The dual MPU core architecture allows the main processor to be 
free from management of the integrated I/O. The integrated I/O allows for lower system 
production costs and flexibility in product designs using a common platform approach. The 
integrated LCD/Video controller is cost efficient for products requiring a display. 
 
Motorola, in partnership with Metrowerks, provides complete technical support for development. 
From startup to custom engineering, embedded development experts are available for questions. 
A variety of training programs are available. Customized training, custom design, software 
development, and consulting services can also be provided. 
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2 mobileGT SDP Contents 
 
The mobileGT SDP contains the following components: 

• mobileGT target system 
• Quick Start Guide 
• mobileGT Software Development Kit 

• Motorola mobileGT Quick Start CD 1.0 
• CodeWarrior for QNX Neutrino 2.1 
• QNX6 Cross Development Kit, Windows Host 
• IBM VisualAge Micro Edition 1.4 
• Java Applications Companion CD 

• A serial cable with RJ45 connectors 
• A RJ45 to 9 pin serial adapter 
• Ethernet Cable 
• Ribbon cable/RS232 adapters 
• Power Supply (non-European shipments) 
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3 Host Requirements 
 
The host system needs to meet the following standards: 

3.1 Hardware Requirements 
 
Pentium or higher compatible processor 
128MB of RAM 
Hard disk space: 50Mb CodeWarrior + 200Mb for QNX + 85-458Mb for VisualAge + 10Mb for 
Motorola mobileGT Quick Start 
 

3.2 Software Requirements 
 
Microsoft(TM) Windows (98, NT 4.0 with service pack 5, or 2000) 
 
Adobe Acrobat Reader 4.0 or higher for viewing documentation. 
 
Terminal emulator configured as described in section 6.1. HyperTerminal, which comes with 
Microsoft Windows, will suffice if another is not available. 
 
TCP/IP communications protocol configured as described in section 6.2. 
 
TFTP (Trivial File Transfer Protocol) utility configured as described in section 6.3. 
 



 4

4 Connecting Hardware Components. 
 
The mobileGT development system was constructed to make it easy to connect and get running 
as fast as possible. Simply supply the power and hook up serial and Ethernet cables. Refer to 
Figure 1 regarding component connections. 

Figure 1 Hardware Components 

 
 

4.1 Power Supply   
 
The power supply (not included in European shipments) provides 5VDC at 2.8A to power all the 
hardware contained within the mobileGT target system, including the RPX Lite� board, H 
Expansion Card, LCD, LCD back light, and touch screen. The input for the power supply ranges 
from 100-240VAC, 50-60Hz, so it should work equally well in Japan, North America, and Europe, 
provided that the proper physical connectors (not included) are used. 
 
The power supply connects to the RPX Lite board on the front of the board (accessible at a 
through-hole in the mobileGT target system) at physical connector P16 (See Figure 1). 

Power  

Ethernet Cable 

Serial Cable 
Reset  
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4.2 Serial Connectors 
 
Up to four serial ports (SMC1, SMC2, SCC2, and SCC3) can be accessed on the mobileGT target 
system at any one time. The SMC1 must be accessed on the RPX Lite board via an adapter that 
physically connects the RJ-45 port on the RPX Lite to a standard serial DB9 port. The three 
remaining serial ports are accessed on the surface of the HIOX Expansion Card via included 
cables that physically adapt the 10-pin computer board header to a standard serial DB9 port. For 
most host computers, a null modem is not necessary and should not be used. If connecting the 
mobileGT target system to another device, a null modem may be necessary, depending on the 
pinout of the device. Consult the device’s relevant documentation for configuration information. 
 
The mobileGT target system contains two RJ-45 port connectors on the front. The SMC1 cable 
connects to the connector on the right. It is silk-screened MON. See Figure 2.  
 

Figure 2 SMC1 
 

 

Ethernet Serial 
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The other serial connections are made into the HIOX Expansion Card inside the mobileGT target 
system. See Figure 3. The ribbon cables can be pulled out of the box for convenience. Be sure 
that pin 1 of each header, labeled on the HIOX Expansion Card, is properly oriented, so that it 
corresponds to pin 1 of the connector, marked by the red wire of the ribbon cable. 
 

Figure 3 HIOX Card 
 

 
 

4.3 Audio Connections 
The HIOX board will support a stereo line in or microphone input.  It will also support stereo line 
out or a speaker output.  See Figure 3. 

4.4 Ethernet Connections 
 
An Ethernet cable is not provided with the mobileGT SDP. A standard 10-pin RJ-45 Ethernet 
cable will suffice. The Ethernet cable connects to the RPX Lite board on the front of the board 
(accessible at a through-hole in the mobileGT target system) on the left side of physical connector 
P3 silk-screened ETH. 

SCC2 

SMC2 

SMC1/ 
SCC3 

Audio In 

Audio Out 
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5 Installing the Software Components 
 
The mobileGT SDP software tools are made up of software packages from the members of the 
mobileGT alliance. Included are mobileGT Quick Start software from Motorola, CodeWarrior for 
QNX, Neutrino Embedded Systems from Metrowerks, the QNX6 Cross Development Kit for 
Windows from QSSL, and the VisualAge Micro Edition tools from OTI. 

5.1 Installing Software Packages 
 
There are five software installations to complete to use mobileGT. They should be installed in the 
following order: 
QNX6.1 Windows SDK Patch A for mobileGT 
Metrowerks CodeWarrior 
mobileGT Quick Start 
VisualAge Micro Edition 1.4 
Java applications Quick Start 
 
 

5.2 mobileGT Quick Start CD 
 
The mobileGT Quick Start CD contains several example build images, tools, and documentation. 
To install it, simply run the setup utility and provide any preferences when prompted. The utility will 
perform the following tasks: 
Copy example image and build files to the hard disk 
Copy specific utilities to the hard disk 
Create an environment variable, MOBILEGT_ROOT, identifying the location of the installation 
Copy the Embedded Planet PlanetCore� utilities and documentation to the hard disk 
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6 Host Configuration 
 
The mobileGT Quick Start software provides a development environment for embedded systems. 
It provides a fully networked system between the host and the target. Using the networking 
capabilities of both the target and the host, images can be easily downloaded and burned into 
flash memory. A networked configuration is described in Chapter 8 that allows the compilation of 
the application on the host and the ability to run it on the target as it would be run on a desktop 
system. 
 
Three components on the host have to be configured: a terminal emulator, network environment, 
and TFTP server. 

6.1 Terminal Emulator 
 
A terminal emulator is necessary to communicate with the target. Terminal emulator software, 
called Hyperterminal, is distributed with Windows. However; any good terminal emulator should 
work well.  
 
To connect to the mobileGT target system, the terminal emulator must be set up as follows: 
9600 baud with 8 data bits 
No parity 
1 stop bit 
No flow control 
 
Once connected to the mobileGT target system, the baud rate may be changed using the 
PlanetCore utilities. Be sure the baud rate of the terminal emulator is correct. Also, be aware that 
it is possible to set the baud rate of the terminal for the Neutrino terminal and the baud rate for 
PlanetCore to different values.  

6.2 Host Networking 
 
Both the PlanetCore utilities and the Neutrino RTOS support TCP/IP networking across the 
mobileGT target system’s Ethernet port. The PlanetCore utility uses a relatively simple TCP/IP 
stack, so that it can download files using TFTP. Neutrino’s TCP/IP stack is more sophisticated 
and supports a wide range of services. The PlanetCore utility and Neutrino do not run 
simultaneously, so they can be configured separately. However, both PlanetCore and Neutrino 
can be configured to talk to the host computer. This section explains how to configure the host 
machine to talk with the mobileGT software, both PlanetCore and Neutrino. 
 
The PlanetCore utility supports enough of the TCP/IP protocols to TFTP files, but it doesn’t 
support some of the more sophisticated protocols, such as domain name services (DNS) or 
dynamic host configuration protocol (DHCP.) Many corporate networks are set up using DHCP. If 
the host is configured using DHCP, change it to use a static IP address. Consult your local system 
administrator to avoid address conflicts. It is necessary to know the IP address in order to 
configure the target. For additional information on this topic refer to section 7.1. 
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6.3 TFTP 
The PlanetCore utilities use TFTP to transfer images from the host to the mobileGT target 
system. The PlanetCore utility needs to talk to a driver on the host machine in order to obtain the 
files. Several such drivers are available. One is a suite of networking utilities, including a TFTP 
daemon called Exceed, that Hummingbird Communications Ltd. Copyright � sells. There are also 
shareware utilities available.  
 
Configure the TFTP utility to allow read access to a directory. Refer to the documentation that 
comes with the TFTP utility for details. TFTP daemons typically establish a directory in which they 
will look for files.  When ready to download a file, copy it to this directory only, and command the 
PlanetCore utility to retrieve it. 

6.4 Sharing Directories 
 
Neutrino can mount directories on the host machine. During development, this can be a 
tremendous help. It allows execution of applications on the mobileGT target system without 
having to download them into flash. It allows access to all the utilities in the QNX6 Cross 
Development Kit, Windows Host. The networked development image supplied on the mobileGT 
will execute a netconfig application when it is first run.  The netconfig application will create a 
netstart script and will offer the opportunity to mount directories on other systems.  To do this you 
will need the following information about the Windows host: 
The name of the Windows host 
The IP address of the windows host 
The name of the shared directory to be mounted 
The name of the directory as it will appear on the mobileGT system. 
 
In order to mount other directories from the mobileGT target system, share them from the host. 
To share the directories, do the following:  
Open the Windows Explorer�.  
Select the directory that is to be shared. 
Choose File→Properties from the Windows Explorer menu. 
Choose the Sharing tab in the Properties dialog. 
Choose Share As and type in the name for the directory.  
Select the Apply button. 
The share names of the directories are needed when the target is configured. 
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7 Target Configuration 
 
Two components to the software are loaded on the mobileGT target system when it is shipped: 
the PlanetCore utility and Neutrino images. These are similar to the BIOS and Windows on the 
host machine. The PlanetCore utility should be left on the mobileGT target system, but the 
Neutrino images may be replaced. The Neutrino image that is shipped should be a good starting 
point. Eventually, a new Neutrino configuration may be necessary. Changes may be made 
regarding a set of drivers or baud rate, but once the image is changed, it is necessary to reload 
the new image into flash. 

7.1 PlanetCore Loader 
The PlanetCore loader communicates to the host through a serial connection. To access it, start 
the terminal emulator and reboot the mobileGT target system. If it is correctly configured, the 
PlanetCore startup banner displays as shown in Figure 4. If the startup banner does not show up, 
check the connections and refer to section 6.1 for directions on how to configure the terminal 
emulator. If the PlanetCore startup banner does appear, press the ESC key within two seconds. 
The message Autoboot Aborted and the PlanetCore loader prompt should appear.  

Figure 4 PlanetCore Startup Banner 

 
The PlanetCore loader maintains a number of settings in flash. These are easily visible by typing 
SET at the PlanetCore prompt. See Figure 5. The settings control the IP address that the 
PlanetCore loader uses, which host IP address it will communicate with, and how it will boot up 
Neutrino. Figure 5 shows the default settings for a mobileGT target system. 
 
Change the IP and TARGET addresses in order to download the images to the mobileGT target 
system. The IP address refers to the address of the mobileGT target system. The TARGET 
address refers to the IP address of the Windows machine. Make sure that the addresses 
correspond to those identified when the host machine was configured. See section 6.2. 
 
In order to set the IP and TARGET addresses, use the SET command: 
>SET IP 222.222.222.222 
 IP equals 222.222.222.222. 
>SET TARGET 222.222.222.221 
 Target equals 222.222.222.221. 
>STORE 
> 
 
The “STORE” command saves the current PlanetCore settings into flash. They will be retained 
even after a reboot. 
 
If the PlanetCore settings on the mobileGT target system match those in Figure 5, no further 
modifications need to be made. If not, use the SET command as described above to change the 
settings. If uncertain of the acceptable values, simply type SET <fieldname>. The PlanetCore 
loader prompt will display which values may be used. Use the HELP command to learn about 
other commands in the PlanetCore loader. 

PlanetCore Boot Loader v1.02 
Copyright 2000 Embedded Planet. All rights reserved. 
 
Autoboot in 2 seconds. 
ESC to abort, SPACE or ENTER to go. 
Autoboot Aborted. 
> 
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Figure 5 PlanetCore Settings 
>set 
Baud                                    = 9600 
Multiplier   (Clock multiplier)         = 8 
Board                                   = RPXL 
Revision                                = CW 
Processor                               = 823 
Variant                                 = E 
DRam         (MBytes on board dram)     = 16 
Cols         (On board dram columns)    = 10 
NVRam        (KBytes on board NV Ram)   = 32 
Sttm         (Degrees C*10)             = 131 
Twirl                                   = N 
ICache                                  = Y 
SYPCR                                   = FFFF0689 
RAMtest                                 = N 
RestoreCE    (Cannot go to ram if set)  = N 
SerOut       (Serial output of loader)  = Always 
RS232        (Enable rs232 drivers)     = Y 
IP                                      = 100.0.0.2 
Target                                  = 100.0.0.1 
File                                    = dev.loadme 
ENET                                    = 0010EC001439 
DefaultENET                             = ENET 
TftpRAM                                 = High 
Start                                   = FF000210 
Format                                  = Flash 
Autoboot                                = Confirm 
> 
 
Refer to the PlanetCore Boot Loader User’s Manual from Embedded Planet for more detailed 
information on the PlanetCore loader. 

7.2 Self-Configuring the Installed Neutrino Image 
 
The mobileGT Quick Start Kit comes with a self-configuring image that enables application 
development for mobileGT to begin immediately. The first time the mobileGT target system boots, 
the image executes a netconfig application that creates a script to start the network drivers. The 
netconfig application prompts for the IP address of your mobileGT target system and other 
network configuration information. It then creates a script that runs every time the system boots 
up. Thereafter, every time the mobileGT target system boots, it automatically starts the network 
drivers and attempts to mount any specified directories. The recommended directories are those 
mentioned in section 6.4. If directories are mounted, any Neutrino applications for PowerPC 
processors that reside in the subdirectories of those mounted directories can be executed on the 
mobileGT target system.  
 
A sample execution of the netconfig application is shown in Figure 6.  “netconfig” may be run 
several times, if necessary, to change the network configuration. 
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Figure 6 Running netconfig 
 

# netconfig 
Welcome to the mobileGT 823e Platform 
 
        [1] Create netstart script 
        [2] Remove netstart script 
        [3] Quit 
 
Please enter choice: 1 
Creating netstart script 
Please enter a name for the mobileGT development system: MGTdevsys 
Please enter the IP address the mobileGT devlopment system: 100.0.0.1 
Please enter the gateway address: 100.0.0.254 
Please enter the network mask: 255.255.255.0 
Please enter the NFS server IP address: 100.0.0.5 
Will you be mounting to a UNIX or QNX host (Y/N)? y 
Please enter the host machine name: QNXhost 
Please enter the NFS host IP address: 100.0.0.4 
Please enter the absolute host directory: /home/mgt 
Please enter the local absolute directory: /qnx/mgt 
Will you be mounting to a UNIX or QNX host (Y/N)? n 
Will you be mounting to a WindowsNT host(Y/N)? y 
Please enter the host NT machine name: NThost 
Please enter the NT host IP address: 100.0.0.3 
Please enter the absolute host directory: /mgt 
Please enter the local absolute directory: /nt/mgt 
Pl b t h thi di t f NT hi
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8 The Networked Development System 
 
The networked development system links the mobileGT target system with the host computer. It 
provides the ability to compile applications on the host and to immediately debug them on the 
target. The image running on the target can establish a TCP/IP connection to the host, allowing it 
to mount directories on the host and run a debug interface to the CodeWarrior development 
environment.  

8.1 Creating a CodeWarrior Project 
 
CodeWarrior for QNX provides project templates designed to work with Neutrino. Creating a 
CodeWarrior project using the QNX project template provides the correct configuration options to 
build applications quickly and debug them easily.  
 
By default, the ‘%MOBILEGT_ROOT%/home’ directory is mounted as ‘/mgt’ by the networked 
development image. If a subdirectory of this directory is used as a base for the CodeWarrior 
project, the application can be run on the target by using the full path. 
 
To create a new CodeWarrior Project, do the following:  
Launch CodeWarrior. 
Select File→New. The New dialog will pop up.  
Choose the Project tab. 
Select QNX Neutrino PPC Stationary.  
Type in a pertinent project name. 
Select the Location of the root of the project, e.g. “c:/Program Files/mobileGT/home.”   
Click the OK button, and CodeWarrior creates a project with the given specifications. 
 
Once the project has been created, it needs to be customized. Specifically, the debug interface 
uses TCP/IP, and the project needs to be told where to gain access to processes running on the 
mobileGT target system. To change the debug interface, do the following: 
Choose Edit→C++ debug Settings…  
In the Target Settings Panels of the C++ debug Settings dialog, select the Connection Settings 
under the Debugger tree.  
In the View Connection Type dropdown list, select View TCP/IP Settings.  
In the Host Name text box, type in the IP address of the mobileGT target system followed by 
:10000, e.g., 222.222.222.222:10000. 
Select the OK button. 
 
The debugger should now be able to communicate with the pdebug driver running on the 
mobileGT target system. 

8.2 Compiling and Running Applications for Neutrino 
 
CodeWarrior provides an integrated development environment for compiling and debugging 
applications on the target.  For details on using CodeWarrior, please refer to the CodeWarrior IDE 
User Guide and the CodeWarrior Targeting QNX Neutrino guide. 
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8.3 Connecting to the Target through Telnet and FTP 

The Networked Development System supports both Telnet and FTP. In fact, a Telnet interface 
may be used instead of the serial shell. Both incoming and outgoing connections may be made. 
Initially, only the root login with a blank password may be used.  New accounts may be added 
using the “passwd” command from a Neutrino shell. 
 



 15

9 Alternative Build Images 
 
The mobileGT Quick Start Kit provides a number of build files and images for the mobileGT target 
system. The build files are intended to provide examples for configuring Neutrino for the mobileGT 
target system. Various combinations of hardware are enabled through the drivers in the build 
images.  

9.1 Images for each Basic Target Configuration 
 
The mobileGT Quick Start Kit provides support for six build images. Each image starts a set of 
hardware drivers that enable features of the mobileGT target system. Thirteen features are 
addressed in the build images, but all thirteen of them are not possible in the same configuration. 
For instance, the audio drive uses the same pins on the MPC823e as the serial driver does on 
SMC2.  Also, the touchscreen uses the same pins as the serial on SCC3.  Table 1, indicates the 
features available on each of the six build images. 
 

Table 1 Build File Configurations 

ID SCC2 SCC3 SMC1 SMC2 H/W Features
Build File 
Name

Corresponding 
HIOX 
Configuration 

A

RS232 
(handshake) 
(HIOX)

RS232 
(handshake), 
SCC3 CD signal 
available 

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

RS232 (no 
handshake)

LCD, no TOUCH, 
no Audio config_a.build 1

B

RS232 
(handshake) 
(HIOX)

not available 
since 
touchscreen 
enabled

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

not available 
since audio 
enabled

LCD, TOUCH, 
Audio config_b.build 4

C

RS232 
(handshake) 
(HIOX)

not available 
since 
touchscreen 
enabled

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

RS232 (no 
handshake)

LCD, TOUCH, no 
Audio config_c.build 5

D Ethernet (CPU)

RS232 
(handshake), 
SCC3 CD signal 
available 

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

RS232 (no 
handshake)

LCD, no TOUCH, 
no Audio config_d.build 1

E Ethernet (CPU)

not available 
since 
touchscreen 
enabled

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

not available 
since audio 
enabled

LCD, TOUCH, 
Audio config_e.build 4

F Ethernet (CPU)

not available 
since 
touchscreen 
enabled

RS232 (no 
handshake) 
(CPU enabled, 
HIOX disabled)

RS232 (no 
handshake)

LCD, TOUCH, no 
Audio config_f.build 5  

 
To determine which image is most suitable to use, do the following: 
Review the features listed in columns two through six.  
Identify the correct build file ID in the first column.  
The corresponding build file is listed in the Build File Name column. 
 
The above configurations correspond to various configurations listed in the HIOX user’s manual. 
The last column of Table 1 traces the build configurations here to hardware configurations in the 
HIOX User’s Manual. 
 
After choosing the appropriate configuration, it needs to be downloaded. A downloadable image 
for each configuration is provided with the installation. However, at some point, the image will 
need to be customized. Then it needs to be rebuilt. There is a makefile provided with each build 
file for this purpose. The build files create an image ready to download. To build all of the images, 
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type make at a command line prompt. To build a specific image, supply the makefile the target 
name for that image, for instance, “make config_a.” 
 
The makefiles also have a target, clean, to remove the images. Type make clean to remove the 
images and all the intermediate files. 
 
The build utilities produce downloadable S-record files with a.loadme extensions, e.g., 
config_a.loadme. See section 9.2 for instructions on downloading and flashing the images. 

9.2 Reflashing the Image 
 
The PlanetCore loader provides a utility, TFTP, for downloading files across the Ethernet. See 
section 6.3 for instructions on configuring TFTP on the host and section 7.1 on configuring the 
TFTP portion of PlanetCore on the mobileGT target system. 
 
Once TFTP is configured on both the target and the host, the images may be downloaded to the 
mobileGT target system, using the following example procedure: 
Copy the file to be downloaded to the TFTP directory on the host. 
Establish a connection to the mobileGT target system through a terminal emulator. 
Reboot the mobileGT target system. 
Immediately press the ESC key to enter the PlanetCore utility. 
At the PlanetCore loader prompt, type run <filename>. 
 
The file will be downloaded to the mobileGT target system and executed. The image has a flash 
burner attached to it that erases the flash and programs the image into the correct memory 
addresses.  
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Figure 7 Downloading and Flashing an Image 

 
 

PlanetCore Boot Loader v1.02 
Copyright 2000 Embedded Planet. All rights reserved. 
 
Autoboot in 2 seconds. 
ESC to abort, SPACE or ENTER to go. 
Autoboot aborted. 
>run config_a.loadme 
 
 
PlanetCore Flash Burner v1.03 
Copyright 2000 Embedded Planet. All rights reserved. 
 
Start = 0x00120000, target = 0xFF008000, length = 0x000C0608 
 
Erasing, programming and verifying will start in 7 seconds 
Press P to start immediately or ESC to cancel 
Press Space or Enter for more options. 
...... 
 
Erasing 
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10 Training 
 
Each of the companies in the mobileGT alliance has standard training courses that allow 
engineering teams to develop expertise in a focused plan. This allows training efforts to be put 
where they are needed most. These include a variety of courses in QNX, IBM VisualAge Micro 
Edition, CodeWarrior, and PowerPC processor. Contact a mobileGT sales representative for 
information and quotes. 
 
Following is a list of contacts for the recommended standard training courses: 
 
QNX by QSSL, 
Training by QSSL 
 
http://www.qnx.com/support/training/index.html 
 
J9 VM and VisualAge Micro Edition by OTI and IBM, 
Training by Object People 
 
http://www-4.ibm.com/software/ad/certify/vaproducts.html 
 
CodeWarrior by Metrowerks,  
Training by Metrowerks 
 
http://www.CodeWarrior.com/training/ 
 
PowerPC processor from Motorola 
Training by Arnewsh, Inc. 
 
http://www.arnewsh.com/training.html 
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11 Support 
 
Besides exploring the mobileGT web sites and training on the system, support is also available. 
An experienced, embedded-development team is on call to furnish quick answers to both simple 
and complex questions to keep the project moving and the delivery on schedule. 
 
When the initial support expires, extend the support for as long as necessary. This allows the 
flexibility to purchase support for small projects or large. The support is available regionally, as 
well, for the appropriate support response. Contact Metrowerks for more information and pricing. 
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12 Custom Engineering & Professional Services 
 
Expert consultants are ready to help evaluate requirements, recommend solutions, and provide 
design services. Custom-tailored training programs are available to meet specific needs. Cross-
company experts can offer solutions. Embedded systems developers can provide custom 
hardware and/or software development. Use these services as much, or little, as needed. Contact 
your Motorola sales office for custom engineering services. 
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13 Troubleshooting 
 
Problem Possible Solutions 
Cannot access the PlanetCore utility across the 
serial connection. 

Check the physical connections. See section 
4.2. 
Check the serial configuration. See section 6.1. 
Reboot while repeatedly hitting the ESC key. 
Try different baud rates. 
It is possible to turn off the serial output from 
the PlanetCore utilities. To recover, try resetting 
the PlanetCore from the EEPROM. Refer to 
Embedded Planet’s manuals for directions. 

Cannot download files to the host from the 
mobileGT target system. 

Make sure the IP addresses listed in the Target 
and IP settings of the PlanetCore utility are 
correct. See section 7.1. 
Make sure the TFTP utility is configured. See 
section 6.3. 
Make sure the file that is downloading is in the 
TFTP directory on the host. 

Cannot access the flasher utility. Make sure %MOBILEGT_ROOT%/bin is in the 
PATH environment variable. 

Neutrino image will not boot. Make sure the Neutrino image and PlanetCore 
utility are talking at the same baud rate.  
Make sure the IPL and signature files are in 
place. These files reside in sector 0xFF000000 
of the mobileGT target system.  
Make sure that none of the images overlap in 
the address space. 
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14 Glossary 
 

Table 2 Glossary 

QNX 6.1 QNX 6.1 is a product from QNX Software Systems Ltd. It includes the Neutrino 
RTOS and the Photon GUI. The mobileGT Standard Development Platform 
ships with the QNX6.1 Cross Development Kit, Windows Host.  

J9 J9 is a Java Virtual Machine from Object Technologies International. It is 
distributed as part of VisualAge. Versions are available that run on Neutrino 
and Microsoft Windows. 

VisualAge VisualAge is a multiplatform Java development environment that runs on the 
Microsoft Windows host. It provides the cross development Java tools to build 
and debug applications for both Windows and Neutrino. 

CodeWarrior CodeWarrior is an integrated development environment that runs on the 
Microsoft Windows host. It provides project management and debugging tools 
for doing cross development for the Neutrino target. 

mobileGT 
target system 

The mobileGT target system is a PowerPC development system built by 
Embedded Planet. It consists of a RPX Lite board, IOX card, LCD, and touch 
screen. It is packaged in a red acrylic box and shipped with a Networked 
Development System already installed. 

RPX Lite The RPX Lite is a board on the mobileGT target system that includes a 
MCP823e PowerPC processor, 16 Mb of FLASH, 16Mb of RAM, a serial 
interface, Ethernet interface, and PCMCIA connector.  

SDP SDP is the acronym for Standard Development Platform. 
Networked 
Development 
System 

Networked Development System refers to a particular Neutrino image that is 
shipped with the mobileGT SDP. This image allows users to configure it to their 
environment, as well as begin writing applications and debugging immediately. 

HIOX The HIOX card is an I/O interface card supplied with the mobileGT target 
system. It has interfaces to additional serial connections, LCD, touch screen, 
and audio. 

QSSL QSSL is the acronym for QNX Software Systems Ltd. 
OTI OTI is the acronym for Object Technologies International. 
Neutrino Neutrino is the Real Time Operating System from QNX Software Systems 

shipped with mobileGT. Neutrino is a component of QNX 6.1. 
RTOS RTOS is the acronym for Real Time Operating System.  
MPU MPU is the acronym for a Micro Processor Unit. 
HMI HMI is the acronym for Human Machine Interface.  This differs from a GUI in 

that it can incorporate non-graphical aspects of an interface such as speech or 
sensory data. 

GUI GUI is the acronym for Graphical User Interface. 
Photon Photon is a microGUI from QNX Software Systems shipped with mobileGT. 

Photon is a component of QNX 6.1.0. 
Build file A build file is a file describing how the image should be built. It is used in 

conjunction with the QNX utilities mkifs and mkefs. It lists the drivers and 
directories needed by the image and can contain scripts used by the image. 

Image  An image is a file that contains a file system partition for Neutrino. It may 
contain the kernel or a file system to be mounted. 
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15 References 

15.1 Publications 
The following publications are provided with the Installations. 
 
Motorola 
 mobileGT MPC823e Standard Development Platform User’s Manual 
 mobileGT Quick Start Guide 
 PowerPC MPC823e User’s Manual 
 
Metrowerks’ CodeWarrior 
 CodeWarrior IDE User’s Guide 
 CodeWarrior Porting Guide 
 CodeWarrior Scripting Reference 
 CodeWarrior Targeting QNX Neutrino 
 
IBM/OTI’s VisualAge Micro Edition 
 VisualAge Micro Edition 1.4 Quick Start Tutorials 
 VisualAge Micro Edition 1.4 Reference Manual 
 
Embedded Planet 
 RPX Lite CW Getting Started 
 RPX Lite CW User Manual 
 RPX Lite CW Programming Manual 
 HIOX BW User Manual 
 HIOX BW Programming Manual 
 PlanetCore Version 1.2 Overview User Manual 
 PlanetCore Version 1.2 Boot Loader User Manual 
 PlanetCore Version 1.2 Flash Burner User Manual 
 PlanetCore Version 1.2 Diagnostic and Utilities (Release 1) User Manual 
 PlanetCore Version 1.2 Diagnostic and Utilities (Release 1) User Manual 
 
QNX Software Systems 
 QNX  SDK for Windows Help 
 QNX Photon Help 
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15.2 Websites 
Motorola Corporate 
 http://www.mot.com/home/index.html 
 
Motorola Semiconductor Products Sector 
 http://e-www.motorola.com/ 
 
Motorola mobileGT Page 
 http://e-www.motorola.com/automotive/mobilegt/ 
 
Metrowerks  
 http://www.Metrowerks.com/ 
 
OTI 
 http://www.oti.com/ 
 
IBM VisualAge Micro Edition 
 http://www.embedded.oti.com/ 
 
Embedded Planet 
 http://www.embeddedplanet.com/ 
 
QNX Software Systems 
 http://www.qnx.com/ 
 
QNX Developers Network 
 http://www.qdn.com/ 
 
 
 

http://www.mot.com/home/index.html
http://e-www.motorola.com/
http://e-www.motorola.com/automotive/mobilegt/
http://www.metrowerks.com/
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http://www.qnx.com/
http://www.qdn.com/
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